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Chapter 1: About this Guide
In This Chapter

• Intended 
Audience

• Conventions

• Getting Help
The MicroVision Camera is an integral part of the MCS Perfect 
Match, IR Track, Input, and Read and Print systems. The camera 
reads a variety of readable image types and decodes (or passes) 
the image. The software that accompanies the camera is 
Windows-based and intended to configure camera operation. 

Note: The MicroVision Camera is a productivity tool. It is used to 
assist in print production but not to replace standard quality 
control procedures.

This document describes how to install and use the camera within 
these systems. For systems that print, this document assumes that 
you have already installed the MCS Printer software and have 
read the accompanying User’s Manual.

Intended Audience

This guide is intended for use by MCS equipment operators. 

Basic knowledge of the Microsoft Windows® operating system 
and some experience with MCS printing equipment is assumed.

Conventions

The following conventions are used in this guide.

Getting Help

A complete on-line help system is available in the interface by 
selecting the Help item on the Menu bar or the Help icon on the 
toolbar.

Convention Description

Bold Actions you should take such as text or data to 
be typed exactly or items to click.

Italics Items to type for which you must supply a 
value.
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Getting Help

About this Guide
If you need further assistance, please contact MCS via e-mail at 
technicalsupport@mcspro.com or call 877.MCS.PROZ (877.627.7769). Telephone 
support for MCS equipment is available 8:30am to 8:00pm EST Monday through Friday 
and is free of charge. 
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Chapter 2: Getting Started
In This Chapter

• Camera 
Installation

• Software 
Installation

• Dongle 
Installation

• System Power 
Up

• MCS Systems
The MicroVision camera can help track, verify, and count on 
many pieces of equipment including inserters. The camera takes a 
picture of a readable image type and decodes (or passes through) 
what it sees. How it translates that data is determined by your 
setup. You can read, match, pass, and print data. In order for this 
interaction to occur, you must install the camera and the camera 
software, and set up the camera via the software as well as 
configure how the camera interacts with the MCS Printer. This 
chapter describes camera installation and setup.

In general, installation should adhere to the following order, 
assuming that physical installation of all the components, except 
the camera, has been completed:

1. If applicable to your setup, install MCS Printer software. See the 
Array Imaging System Software User’s Manual and GIS 4250 
Software User’s Manual for instructions. 

2. If printing, create Special Batch files. See “Installing Special 
Files” on page 2-13.

3. Install MicroVision Camera software. See “Software Installation” 
on page 2-11.

4. Install the camera dongle and dongle license. See “Dongle 
Installation” on page 2-11.

5. Install the Camera. See “Camera Installation” on page 2-1.

6. Make any required manual Settings.ini file changes. See 
“Settings.ini” on page 2-19.

7. Add the Camera(s). See “Add Camera” on page 4-1.

8. Configure Readable Images. See “Readable Image Types” on 
page 5-1.

9. If printing, print the job.

Note: There may be specific instructions based upon the type of MCS 
system you are using. Be sure to refer to “MCS Systems” on page 
2-12 to review descriptions of your system.

Camera Installation

Camera Placement

There is a variety of MCS equipment on which the MicroVision 
camera can be installed: 
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Camera Installation

Getting Started
• As an input to other MCS-approved equipment
• Inserters (Friction-Feeder, Swing Arm)
• Card Attachers
• Inkjet Transport Base
• Continuous Form Transport Base
• Continuous Form Rewinder
• Folders 
• Stitchers

A camera is triggered by cycle count either from an encoder (electrical/software) or an 
external trigger (physical device), depending upon camera placement and/or equipment 
choice. For example, a Pitney Bowes FlowMaster install utilizes an onboard encoder 
whereas a Swing Arm inserter utilizes external triggers to generate cycle and camera 
triggers.

MCS provides recommendations based on the type of system you are using.

Inserters

Friction-Feeder Style

• Camera Placement Option 1 - Facing down toward track, mounted above track
2-2
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Camera Installation
Getting Started
• Camera Placement Option 2 - Facing up, reading each piece as it exits the feeder

• Camera Placement Option 3 - Facing up toward the track, mounted under the track 
(generally requires modification to track – MCS technicians can determine whether 
this is possible)

In general, when facing up or down in the track, the camera is triggered via the inserter’s 
on-board encoder. 
2-3
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Camera Installation

Getting Started
When the camera is mounted facing up, reading each piece coming out of the feeder, an 
external trigger source (usually a beam sensor) is used. Additionally, limitations of the 
read-up configuration are dictated by the placement of the image to decode in relation to 
the belts of the feeder.

Swing-Arm Style

• Camera Placement Option 1 – Facing down toward track, mounted above the track
• Camera Placement Option 2 – Facing up, reading each piece as it exits the feeder 

(some limitations may occur on some feeders, as the gears and mechanics of a 
typical swing arm may prevent placement of the camera on the last feeder. An MCS 
technician can determine what’s available for mounting)

• Camera Placement Option 3 – Facing up toward the track, mounted under the track 
(generally requires modification to track – MCS technicians can determine whether 
this is possible)
2-4
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Camera Installation
Getting Started
Swing Arm style inserters are typically set up using an external trigger source. A series 
of proximity sensors are mounted near the drive shaft, in conjunction with collars that 
are placed to simulate the timing effect of a cycle count, as well as the camera triggers. 

An MCS technician will install these and train you on proper adjustment for different 
jobs.

Attacher, Transport Bases, Rewinders, Folders, and Stitchers

Normal camera placement on these types of equipment is facing down. These types of 
camera installs always require an external trigger source, which is usually each 
individual piece (for cut sheet forms) or a timing mark (for continuous forms).
2-5
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Camera Installation

Getting Started
Physical Installation

Physical installation of the camera involves attaching the camera to the device, 
connecting it to the computer, and installing its driver. Equipment choice dictates 
whether it will be triggered by an encoder or internal sensor.

To install the camera and camera driver:

1. Attach Camera to device.

The device can vary and placement can vary depending on the type of printing system 
used. See “Camera Placement” on page 2-1. 

2. Plug the USB cable connector into camera. 

Note: Make sure that the USB cable is inserted correctly into the camera port. The Narrow end 
of the port must match the narrow end of the cable connector.

3. Plug in Trigger cable connections as needed for your setup. See “Equipment 
Connections” on page 2-7 to evaluate and complete your physical connections. 

4. Plug USB cable into the computer’s USB port.

A separate USB card is recommended. A Windows Found New Hardware message pops 
up and the New hardware wizard is launched.

5. Follow the wizard and select Install from Specific Location.

6. Browse to select C:Program Files>MCS Perfect Match>Driver.

7. Click OK.

8. Click Next. 

The Install PM USB Driver security message appears.

9. Click Continue anyway.

10. Click Finish.

USB Port

Trigger Port
2-6
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Camera Installation
Getting Started
Note: The lens cap must be removed from the camera before use.

Equipment Connections

The following diagrams provide a typical description of camera connections for a 
swing-arm inserter, PLC-type inserter, and an IR Track.

Note: Additional connections may be needed for inkjet setup.
2-7
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Camera Installation

Getting Started
Swing-arm Inserter

Transport

Proximity Sensor
Exit Sensor Programmable Sensor

MicroVision Controller

Typical Windows XP PC
USB HUB

MicroVision Camera

Camera Dongle

e-stop
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Camera Installation
Getting Started
PLC-type Inserter

Transport

Diverter Programmable Sensor

MicroVision Controller

Typical Windows XP PC
USB HUB

MicroVision Camera

Camera Dongle

PLC-Encoder Panel

e-stop
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Camera Installation

Getting Started
IR Track

Transport

Programmable Sensor

MicroVision Controller

Typical Windows XP PC

USB HUB
MicroVision Camera

Camera Dongle

Array Print Controller

e-stop
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Software Installation
Getting Started
Software Installation

The first installation of the camera software is done by an MCS factory trained 
technician at your facility.

Minimum system requirements to perform upgrades are:

• Pentium processor
• Windows XP Professional
• 1 GB RAM
• CD ROM drive

Note: A serial COM Port connection is needed for the Perfect Match System.

There is no way to manually install or uninstall the software on a PC by deleting or 
copying files. You must run Setup.exe to install the software.

To install/upgrade the software:

1. Uninstall any currently installed version using the Windows Remove Programs 
mechanism.

Access this window by selecting Start>Control Panel>Add or Remove Programs and 
then select the MicroVision Software. Click Remove.

2. Run Setup.exe for the version you would like to install.

3. Follow the setup wizard.

Dongle Installation

The MicroVision camera software requires a hardware dongle. A dongle is a hardware 
device that allows your equipment to communicate with the MCS software. If you 
attempt to use the software without the dongle installed, it will not function. You will 
receive an error.

To install the dongle from the installation CD:

1. From the installation CD, double-click the file DongleInstallation/Hdd32.exe in the 
Dongle installation folder.

This executable installs the drivers to operate the dongle.

2. Follow the instructions.

3. Double-click the file DongleInstallation/DongleReader.exe.

This program verifies driver installation and proper operation.

4. Insert the Dongle into a USB port.

The dongle operates in any USB port; however, an internal port is recommended for 
added security.
2-11
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System Power Up

Getting Started
5. Go to Start>Dalso Coreco>Sapeca>License Manager and click Load License.

A window appears with license numbers found.

6. Click the license number for this dongle. 

7. Click Open.

System Power Up

You must power up the PC before the camera box. This order is important because the 
serial connection will only look for data one time. If the PC is not powered up, camera 
initialization may fail.

MCS Systems

The camera can be used with each of the MCS Systems described below:

System Description

Read and Print The Read and Print configuration of the Perfect Match system combines the camera identification process with the 
functionality of an MCS inkjet printer. The camera now controls the print order.

One camera plus an MCS inkjet for printing. 

 

Match The Perfect Match system uses the MicroVision camera to match data matrix barcodes, linear barcodes, and OCR 
alphanumerics on multiple variable printed pieces.

Matches two or more printed pieces. Uses multiple cameras. 

 

Match and Print Multiple cameras plus a inkjet printer. Matches and prints. 

  

IR Track The MCS IR Track system can work on either a continuous form laser printer or in the continuous form bindery lines 
to create match jobs with no visible automation marks. This system differs from traditional Read and Print because 
there is no database associated with the IR Track. What the camera reads from the laser printed material is what is 
transposed to print in invisible ink. Multiple cameras for the back of the laser printer. 

  

Input Camera This system decodes and passes data via serial or ethernet connection to some other piece of equipment.

  
2-12
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MCS Systems
Getting Started
Read and Print

The required items for this setup involve both the inkjet software and camera software. 
The following text provides a brief description of the needed items.

In the Inkjet software, load the job, template, and data file and make sure your 
setupmatch.cfg file is correctly set. Know your unique identifier in the data file. In the 
camera software, make the necessary changes for the unique identifier in the Setup.ini 
file, create/load the camera job, setup the camera and readable images, and enable the 
job.

The following MicroVision Camera functions apply only to setup and operation of the 
Read and Print system.

Installing Special Files

MCS has created special files that make it easier for your camera and the MCS Printer to 
communicate. Once the camera and MCS Printer software have been installed, you can 
install the special files.

These files copy your printer’s Setup.cfg file and make the appropriate changes to the 
file needed to interact with the camera. When printing, use the file for your setup (Match 
for Perfect Match or Print for Printers) to invoke the printing software. 

Note: If you desire changes to your printer’s configuration file and you are using a camera, be 
sure to make the changes to the .cfg file for the system, not the default Setup.cfg.

To install special files:

1. Double-click PrintPCSetup.exe.

Two icons are placed on your desktop. These files allow you to run the camera with 
(SetupMatch file) or without (SetupPrint file) an inkjet. These files will be used when 
running the job.

Enabling the Job

After all setup and configuration is complete, you must enable the Read and Print print 
job from the camera software’s Run tab. The Print button activates the printer and uses 
any existing MCS Printer settings. You must have the special files installed on your 
desktop.

Missing Records

This option can be used only when your MCS Printer is being used in the system. This 
option can be selected while a job is running. It creates a file that contains a list of how 
many records are left to print or leftover without printing. You must set the Dupe 
Checking line in the MCS Printer config file to 1 for this feature to work. 
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MCS Systems

Getting Started
Unique Identifier in the Data File 

Using the standard MCS Printer data file, place the unique identifier (index number) in a 
separate field in your data. Once the field is identified, the field number must be updated 
in the setup file. 

Note: The data mask in the settings.ini file must match the number of digits (e.g. 7 digits 
equals #######). 

Note: You must use leading zeros. 

Six or seven digits are recommended. The number of digits must be consistent within a 
file. If you have one million or more, 7 digits is necessary.

Do not use the same unique identifier within a job, even if you split the file into multiple 
segments. 

The Data Mask is located under the [System] group in the Settings.ini file. See 
“Configuration Files” on page 7-1 for a detailed explanation of this file.

IR Track

The IR Track System fits into your current continuous print operations or continuous 
form bindery line. The system can be used to apply invisible automation marks or as a 
method to add security information to printed documents. It can even be used to add sort 
control marks to increase productivity. No database is necessary for the invisible print to 
be appended. 

The system reads preprinted unique identifiers and uses that information to print 
invisible unique identifiers. Once printed, invisible identifiers can be read by 
2-14
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MCS Systems
Getting Started
MicroVision cameras. This results in printed pieces with no visible automation marks 
that can now be matched.

The system can mount on a continuous forms table or a forms Rewinder. The following 
diagram shows the front and back view of a typical installation.

In a typical IR Track scenario, pages are printed 2-up with a trigger mark and a unique 
identifier (such as a bar code) on opposite sides. The trigger/timing mark needs to be a 
repeatable, detectable object that is the only thing that the sensor will detect within its 
vertical path. The visible barcode is printed by your continuous laser printer. It is 
2-15
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MCS Systems

Getting Started
defined in your document-composition software (i.e., Anchor Max Designer, GMC 
PrintNet). Both marks are placed in an area to be trimmed off later. 

The visible barcode is defined as the combined values of the unique identifiers for both 
records of the 2-up form. For instance, the name on the left may have a unique identifier 
of “0000001”, while the name on the right side of the 2-up form has a unique identifier 
of “0723001”. When concatenated together, the left and right side unique identifiers 
would create the value “00000010723001”, which is created as the visible black barcode 
in your trim area.

The position of the barcode is dependent on the placement of your timing/trigger mark. 
Generally, it is easiest if they are placed along the same horizontal plane. However, a 
change in the physical placement of the trigger sensor can affect a change of the 
2-16
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MCS Systems
Getting Started
placement of the barcode, thereby changing the placement of the invisible barcodes on 
the form itself. (The camera that reads the laser printed barcode is immediately triggered 
by the sensor. Movement of the trigger sensor allows you to move the vertical placement 
of the barcode.) When the timing/trigger mark is on the same horizontal plane as the 
barcode, the equipment is set up as shown.

Understanding the relationship between the trigger sensor and the camera is vital to the 
concept of how the IR Track system operates. Below is an example of what happens 
when the physical placement of the trigger sensor is adjusted. You can print your 
invisible codes lower on the form. You need to be cognizant of this placement, so that 
you do not go too far, resulting in the invisible barcodes printing on the next/wrong 
form.
2-17
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MCS Systems

Getting Started
Determining the Distance from Sensor

Define the measurements that are required to print and verify the invisible barcodes. 
What you see below is considered “Starting Position”. Jog your form to this position 
(with the sensor directly over the timing/trigger mark). From here, measure the distance 
from the beginning of the print head to the place on the form where you would like the 
invisible barcodes to be printed. This is your “Distance from Sensor” value entered in 
the I/O settings. See “I/O Settings” on page 4-6 for details. 

Defining Trigger Ticks Value

Measure the distance from the center of the camera (mounted behind the print head) to 
the place on the form where you would like the invisible barcodes to be printed. This is 
your “Trigger Ticks” value. (Be aware that the value cannot be greater than the length of 
the form.) Trigger ticks are the value entered in the Settings.ini value as encoder ticks. 
To define this value, calculate the number of encoder ticks time 300. So, the value 
entered for encoder ticks with a 5.25 cycles would be 1575.
2-18
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Settings.ini
Getting Started
MCS Input Camera System

This system decodes and passes data via serial or ethernet connection (e.g., 509 Caps 
system as control of GBR Collator on the front of an inserter). Used in this way, the 
camera decodes and then passes this information to another piece of equipment. The 
camera has no control over the end use equipment.

When using the camera in this fashion, you must enter the camera settings in the 
configuration file. For each camera, the following settings must be entered. The first 
camera will have default setting. You can copy the lines and change the camera number 
for additional cameras.

Camera.#.ComPort
Camera.#.PassResult
Camera.#.FailResult
Camera.#.ExternalDecodesOnly
Camera.#.BarCodeReadFormat
Camera.#.BarCodeNmChars

Settings.ini

The Settings.ini file contains information specific to your system setup. While .cfg files 
described in “Installing Special Files” on page 2-13 are created for you, the Settings may 
require some manual configuration. All settings in the file must match your exact system 
configuration. For example, the Exit Sensor number in the [System] group must match 
the input number on the controller box. Certain items must be set in this file and cannot 
be done via the software. 

For Perfect Match, these items are:

• Data Mask

See “Perfect Match System Settings.ini” on page 7-1 for a detailed explanation of this 
file.

In addition, you must also change the Key Field in the TCP/IP section of the 
SetupMatch.cfg file to reflect the correct field number where the unique identifier is 
located. If you do set this field you may get invalid comparisons or duplicates.

For IR Track, these items are:

• Distance.inches
• Double.Trigger.Inches
• Barcode.Num.Digits
• Trigger.Ticks
• Read.Mask
• Write.Mask
• Piece.Width.Inches
• Dist.From.Sensor.Inches
2-19
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Settings.ini

Getting Started
See “IR Track System Settings.ini” on page 7-5 for a detailed explanation of this file.
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Chapter 3: Understanding the Interface
In This Chapter

• Opening the 
Application

• The Main 
Window

• Title Bar

• Menu Bar

• Toolbar

• Display Area

• Tab Selection 
Area

• Intensity 
Histogram

• Results Area

• Camera Zoom

• New, Open, 
Save, Save As

• Debug Window
The MicroVision camera software is a Microsoft Windows-style 
application. It is important to understand how the interface works 
so that you may use the interface most effectively.

Opening the Application

The MicroVision camera software can be opened in many ways, 
one of which is described here.

Note: Make sure your camera and dongle are connected prior to 
opening the application.

To open the application:

1. Double click the MicroVision icon on your desktop.

Note: You may open the application using other Windows standard 
techniques.
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The Main Window

Understanding the Interface
The Main Window

The Main Window is the primary point of entry for all tasks. This window is broken 
down into many areas as annotated below. Each area is described in the sections that 
follow.

Title Bar

The Title Bar displays the name of the program, a minimize button, a maximize/restore 
button, and a close button.

Menu Bar 

This standard Windows feature contains pulldown menus to select functions. Functions 
which cannot be used appear dimmed (gray). Items in the Menu Bar are interactive. 
They change as tabs are selected in the tab selection area.

Title Bar

ToolbarMenu Bar Display Area

Tab Selection Area
Results Area

Intensity Histogram
3-2
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Toolbar
Understanding the Interface
Toolbar 

The Toolbar contains rows of iconic buttons that provide quick access to common tasks. 

Customizing the Toolbar

The customize option allows you select which icons are shown in the toolbars.

To change icons displayed in toolbars:

1. Select Customize from the View menu and select the desired toolbar to change.

The toolbar window appears.

2. Use the Add and Remove arrow buttons to change the icons displayed.

3. Click OK.

Display Area

The display area is the area in which functions appear. When you select a tab in the tab 
selection area, the display area is repopulated with that information. You then work 
within the display area to execute your tasks.

Tab Selection Area

The tab selection area contains three tabs: Camera, Log, and Run. Selecting a tab 
changes the display area.

The Camera tab is described in detail in “Camera Operation and Setup” on page 4-1. 
The Log tab provides a history of actions performed as well as errors and warnings. The 
Run tab is described below.

Run

Add Camera

Save

Open

New
3-3
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Tab Selection Area

Understanding the Interface
Run Tab

The Run tab provides status while the job is run. 

Note: You can also enable a Read and Print print job from the Run tab.

Lights show read activity and camera status. Printing status lights show if on and flashes 
when printing. The registration sensor flashes once per cycle. The exit sensor flashes 
when it is tripped. The output sensor flashes as well when it is tripped. 

The Clear button physically clears all pieces on the list while Clear Blues clears pieces 
only between the exit sensor and the printer. These option are not available for IR Track 
systems.

When running, the table displays only those display columns that were requested during 
I/O settings configuration. See “I/O Settings” on page 4-6.
3-4
User’s Manual



Intensity Histogram
Understanding the Interface
The following table describes run colors.

Intensity Histogram

The Intensity Histogram is located on the bottom left of the window. It shows the 
intensity of dark and white spaces for the camera to read. It adjusts peak black and white 
valley use as indicated by a dividing line that specifies one side of the line is black and 
the other white.

Results Area

The results area lists your current actions and details about those actions.

Camera Zoom

Camera zoom, accessible via the View menu, increases or decreases the size of the 
picture shown in the display area. It does not increase or decrease the actual picture 
image.

New, Open, Save, Save As

Use these settings available in File menu to create, save, and open your current camera 
settings.

Color Description

Green Success

Red Failure

Yellow Duplicate Read

Pink Match so far - only pertinent with multiple cameras 
reading the same image type.

Tan Invalid key. This may appear when what is passed to 
the inkjet is not in the data file. It may be 
misidentified in the data file.
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Debug Window

Understanding the Interface
Debug Window

To access most of the configuration files and troubleshooting files you need, press 
CTRL-ALT-3. In addition to the files accessed via this window, you may also need to 
click icons which are located on your desktop.
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Chapter 4: Camera Operation and Setup
In This Chapter

• Add Camera

• Focusing the 
Camera

• Remove 
Camera

• Properties

• I/O Settings

• Running the 
Auto Setup 
Feature

• I/O Timing

• Run

• Stop on Error 

• Decode Image 

• Reset Pass/Fail 
Counts 
This section explains how to add and configure your camera(s) as 
well as how to review its operational status.

Add Camera 

Once your camera(s) and software are installed you must add 
your camera(s) to be recognized by the software. A camera can 
be plugged in to the computer and the software may be open, but 
the camera will not be recognized until it is added. 

Note: It is helpful to know the serial number of your camera(s) before 
executing this procedure.

To add a camera:

1. Make sure the camera is properly installed and connected.

See “Camera Operation and Setup” on page 4-1. Note that the 
bottom right corner of the screen indicates the number of cameras 
available. This lets you know how many cameras are plugged 
into the computer that have not been added to the software. After 
you add a camera, the status reads 0 cameras available. 

2. Select the Camera Tab.

3. Click the Add Camera icon.
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Add Camera

Camera Operation and Setup
The Add Camera Window appears.

4. Select the serial number for the camera you are adding.

If you do not know the serial number of your camera, you can select any serial number 
in the list and look at the installed cameras to see which one is flashing. If the desired 
camera is not flashing, select another serial number until you locate the desired camera.

5. Assign a number to the camera.

You can assign any number to the camera. Multiple numbers are listed no matter how 
many cameras you have installed. We recommend that cameras are numbered according 
to placement on the inserter and not based on the order they were added. Select a 
number and click Assign.

6. Click Exit.

Serial 
Numbers
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Add Camera
Camera Operation and Setup
The display area now shows the camera image.

Saving Camera Setup

You can save the camera assignment by modifying the MicroVision camera 
configuration file. 

To save current camera settings:

1. Select Save from the File menu.

2. Provide a name for the file and click Save.

You can open this file the next time you use the software.

Tip: You can save the camera setup and have it reopen with this setup active the next time 
you open the camera software. To do this:

1. Press CTRL-ALT-3.

The debug window appears.

2. Click the MicroVision Settings.cfg button. 

A text window appears.

3. Modify the third line to equal 1. 

4. Save the file.

5. Close the MicroVision camera software.

6. Reopen the MicroVision camera software 
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Focusing the Camera

Camera Operation and Setup
Focusing the Camera

You can focus the camera by adjusting the camera lens position. This is done using the 
set screw. It is important to follow the procedure below to ensure that the screw is not 
dislodged and that no damage is done to the camera or lens during this operation.

To adjust camera focus:

1. Hold the camera straight and using the tool provided, insert the tool through the set 
screw access hole into the set screw. 

2. Turn the tool a half turn to the right.

3. If you have successfully caught the set screw, it will turn no further. If your tool keeps 
turning, you have not caught the set screw. Remove the tool and try again.

4. Once you have successfully caught the set screw, turn it a half turn counter-clockwise. 
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Remove Camera
Camera Operation and Setup
5. You may now grab the lens with your fingers and turn it as needed.

6. When your adjustment is complete, return the set screw to the locked position. Make 
sure you have correctly caught the set screw as in steps 1-3 before turning.

Remove Camera

This feature, accessible from the File menu, removes a camera that had been added. The 
camera may remain connected to the computer, but it will not be recognized by the 
software.

Properties

The Properties window, accessible from the Camera menu, provides status on the 
currently selected camera. It tells you information such as the camera’s number and 
serial number.
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I/O Settings

Camera Operation and Setup
I/O Settings

The I/O settings window allows you to specify parameters about how the camera detects 
pieces on the printer. It is especially important that your Cycles From Exit settings be 
correct in this window to ensure proper setup. 

The MicroVision Camera software can operate with an encoder to trigger the camera or 
with a physical sensor. The I/O settings window displays different options, depending 
on your setup.

To enter I/O settings on a system with an encoder:

1. Select I/O Settings from the File menu.

2. Enter Cycles from Exit and Delay settings for each camera.

The number of cycles represents how many cycles of the machine are between the 
camera and the exit sensor. Delay is the number of ticks in the cycle at which you want 
the camera to be triggered for systems using an encoder. 

For Flowmaster configurations, you can get the encoder ticks value from the timing 
screen.

3. If you have a diverter, enter Diverter settings.
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Running the Auto Setup Feature
Camera Operation and Setup
Check the box to enable the diverter. When enabled, the cycle offset is always one less 
than the primary camera’s cycles from exit setting (e.g., the camera’s cycle is 12, the 
diverter setting is 11). 

4. For Read and Print systems, enter Printer Settings.

When enabled, display columns are the fields in the data file that you want displayed in 
the Run tab. These are usually the most important fields such as the unique identifier 
field for camera decoding. See “Run Tab” on page 3-4 for a description of this tab.

5. Enter Stop Conditions.

Stop conditions are settings that you can define to stop the transport. They are used to 
address any need for intervention. If the numbers are sequential and you want to verify 
this order, check the Stop machine if read numbers are not sequential check box. This 
action is helpful to double check that there are no missing pieces. 1 indicates a high to 
low read and -1 indicates a low to high read. If they are not sequential, this feature is not 
applicable.

It is particularly helpful to use this feature with OCR data. Be sure to check the box 
when running sequential OCR data.

Misreads and mismatches have values of 0 for off. Enter a threshold of misreads before 
a stop. This field may also be used when there is no diverter. 

Mismatch is used when multiple cameras are being used to tell the system to stop when 
values are not equal from one camera to another.

When using a printer, the number of pieces indicates how many pieces can go past the 
exit sensor without reaching the actual printer before printing will stop. This setting can 
avoid a pile up at the print head. These are identified as blue lines on the Run tab. The 
number entered is the maximum load plus one. For example, if the physical number of 
pieces that fit is 5, the number entered is 6. 

Running the Auto Setup Feature

You can also set the cycles and delay settings via the Run tab. This provides accurate 
setting for these fields but can’t be done until you have installed everything else and 
configured a readable image. Its important to optimize these settings so that the exit 
sensor alerts at the proper time.

To get the settings:

1. Click the Run tab.

2. Press CTRL-ALT-3.

3. Click Settings.ini.
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I/O Timing

Camera Operation and Setup
4. Go to the System group and on the first line change Setup Mode to 0. Save the file. 

5. Save any current Camera software settings.

6. Close the Camera software. 

7. Reopen the Camera software. 

The cycles and delay information in the I/O Settings window has been updated.

I/O Timing 

When pieces are running, you can look at this screen to view timing status. To display I/
O timing status, select I/O Timing from the File menu. If printing, an acknowledgement 
can also be included.

Run

The Run feature, accessible from the File menu, takes the camera in and out of decode 
mode.

Stop on Error

When enabled, this feature, accessible from the File menu, displays the errored image on 
screen. The Clear Stop Error removes the image from the screen. This is useful when 
reading OCR characters. It can help identify all characters that need training.
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Decode Image
Camera Operation and Setup
Decode Image

When a tool is selected, you can use this option from the Camera menu to decode the 
image. 

Decode on Tool Update

When enabled, images are automatically decoded when updates are made to the tool.

Reset Pass/Fail Counts

This feature resets the Pass/Fail counts displayed in the Results table for each tool.
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Reset Pass/Fail Counts

Camera Operation and Setup
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Chapter 5: Readable Image Types
In This Chapter

• Printing and 
Converting 
Issues

• Understanding 
the Camera Tab

• Data Matrix 
Barcodes

• Linear 
Barcodes

• OCR 
Alphanumerics
The MCS MicroVision camera software reads Data Matrix 
barcodes, linear barcodes, and OCR alphanumerics. It is 
recommended that you read The Bar Code Book by Roger C. 
Palmer (ISBN 0-911261-13-3) to gain a comprehensive 
understanding of bar codes. The items in this section pertain to 
readable image type descriptions with regard to the MicroVision 
camera.

Printing and Converting Issues

When using either barcodes or OCR alphanumerics, it is 
important to realize that the print quality from your laser printer 
and your conversion process quality are critical for successful 
reads with the matching system. 

When you start printing a job with your laser printer, make sure 
you incorporate quality control procedures regarding the barcode 
or OCR alphanumerics. Look for erroneous printing of dots or 
fuzzy printing. If the entire run is produced with faulty barcodes 
or OCR alphanumerics, there is little you can do to make it work.

When the document is converted (cut and/or folded), it is critical 
that the cut and fold be identical on every form. The camera is 
looking at one spot to read the data, and if the pieces are folded 
even slightly differently, the image will not be properly decoded.

Understanding the Camera Tab

The Camera tab provides access to the camera image, readable 
image tools, and image refinement settings.
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Understanding the Camera Tab

Readable Image Types
Image Tools

Image tools decode the image that the camera sees. To configure how the tool decodes 
the image, click on that tool’s icon. 

Once the tool has been configured, you can modify the tool setting by clicking the Tool 
Properties icon. Configured tools are listed in the tool Results area. When a tool is 
correctly reading an image it is displayed white with Pass text and when it is not, it is red 
with Fail status.

You can also access the tool’s configured settings by double-clicking the tool’s row in 
the tool result area. To remove a tool, click the Remove tool icon. The Blue Rectangle 
tool allows you to narrow the readable area from the full screen to size of the blue box. 
This helps the camera software ignore the extra noise, thereby increasing decode speed.

Image Refinement Settings

The image refinements settings (exposure, gain, orientation, and trigger) adjust the 
clarity of the image displayed. Expose adjusts the amount of light allowed in. Gain 
adjusts the contrast based on the amount let in. It is best to leave the Exposure a bit 
lower and raise the Gain if possible. Be careful not to adjust the gain too high. This will 
produce a grainy image. 
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Data Matrix Barcodes
Readable Image Types
Orientation adjusts the rotation of the image. OCR requires that the image is read left to 
right. It does not matter for other image types. The capture below shows an image after 
image refinement has been performed.

The trigger can be set to External, which detects actions from the machine, or Internal 
from the software, which executes consecutive firing.

In production mode, the trigger mode must be set to External. Decode must always be 
On in production mode.

Data Matrix Barcodes

Data Matrix Barcode Template Placement

The following items provide some specifications for how to place data matrix bar codes 
in the MCS Printer software template.

• Size >= ¼”, <= 1 ½” 
• Cell Size <=12 cells
• DPI >= 300 dpi
• Clear Zone - an area surrounding the image that has nothing but white space

The clear zone must have no other print in area.

The Data Matrix barcode can be printed anywhere that the camera can see it on the 
inserter. The data in the data matrix barcode should be only the unique identifier. 
Leading zeros are required to give the barcode a uniform size though out the job. 
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Data Matrix Barcodes

Readable Image Types
Data Matrix Symbol Sizes

Data Matrix Barcode Tool Configuration

The way the camera decodes the Data Matrix barcode image is configured via the Data 
Matrix Image tool.

To configure Data matrix readability:

1. Click the Camera tab.

Numeric Alphanumeric Symbol Size

6 3 10 x 10

10 6 12 x 12

16 10 14 x 14

24 16 16 x 16

36 25 18 x 18

44 31 20 x 20

60 43 22 x 22

72 52 24 x 24

88 64 26 x 26

124 91 32 x 32

172 127 36 x 36

228 169 40 x 40

288 214 44 x 44

348 259 48 x 48

408 304 52 x 52

560 418 64 x 64

736 550 72 x 72

912 682 80 x 80

1,152 862 88 x 88

1,392 1,042 96 x 96

1,632 1,222 104 x 104

2,100 1,573 120 x 120

2,608 1,954 132 x 132

3,116 2,335 144 x 144

10 6 8 x 18

20 13 8 x 32

32 22 12 x 26

44 31 12 x 36

64 46 16 x 36

98 72 16 x 48
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Data Matrix Barcodes
Readable Image Types
2. Click the Data Matrix tool.

The Data Matrix Tool Properties window appears.

3. If desired, enter a name for this configuration.

If you do not enter a name, a name will be provided for you.
4. Enter the decode Timeout.

The decode time sets how long the camera is given to read the image before a misread is 
reported and the camera moves on to next image. Typically this is left at 50 seconds. The 
number should never be increased over the speed at which you are running. For 
example, if you are running at 10,000, the number should not be more than 100 (1/10000 
equals .0001 which equals 100 ms).

5. Review the Character Length.

This sets how many digits are in the unique identifier. Enter the correct amount of pound 
signs to match the number of digits in the unique identifier field. You can use symbols 
such as (-) or (A) to skip or replace a digit. In the Test field, enter numbers equaling the 
required digits to test that the correct amount of pound signs have been entered. The 
results field will display what will be read if the test numbers were decoded. ##### with 
test data of 12345 will display 12345 in the results field; while A#### will display 
A2345 and #-### will display 1345.

6. Enter the Matrix size. 

Do not use the Automatic setting. Select the correct size. To find the correct size, 
count the number of black and white spaces for length and width, See “Data Matrix 
Barcode Template Placement” on page 5-3 above for explanation on bar code sizes. 

7. Enter Calculate Light on Dark settings.

Dark on light is used for visible barcodes. Light on Dark is used for invisible barcodes.

Note: Invisible barcodes require the use of the invisible barcode camera.

8. Click Threshold.
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Linear Barcodes

Readable Image Types
The Threshold window appears. This window brings up the camera image and allows 
you to adjust the black areas outside of the image.

9. Enter Threshold settings.

The Adaptive Global, Adaptive Local, and Fixed settings allow you to adjust the amount 
of black and white space displayed around the image. Adaptive Global adjusts the circle 
around the image to the maximum image allowed by the camera. Local reduces the area 
closest to the image. Fixed allows you to manually adjust the area and is the most 
commonly used format.

10. Click OK.

11. Check additional options.

You can enable Log reads to enter data in the log file. Checking Outline Read places a 
green outline around the image based on your threshold settings. You can show the 
Thresholds settings and you can enable the Calculate grade option. The Calculate grade 
option provides a score on barcode matching. 

Note: Do not check Calculate grade while the job is running. This is will slow down 
performance.

Linear Barcodes

Some Linear barcodes may not fit in the field of view of the camera. The typical field of 
view is 1.25 inches. If the bar code is larger than 1.25 inches, the camera can not read it. 
Linear barcodes are configured in similar fashion to Data Matrix barcodes. 
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Linear Barcodes
Readable Image Types
To configure Linear barcode readability:

1. Click the Camera tab.

2. Click the Linear Barcode tool.

The Linear Barcode Tool Properties window appears.

3. If desired, enter a name for this configuration.

If you do not enter a name, a name will be provided for you.

4. Enter the decode Timeout.

The decode time sets how long the camera is given to read the image before a misread is 
reported and the camera moves on to next image. Typically this is left at 50 seconds. The 
number should never be increased over the speed at which you are running. For 
example, if you are running at 10,000, the number should not be more than 100 (1/10000 
equals .0001 which equals 100 ms).

5. Review the Character Length.

This sets how many digits are in the unique identifier. Enter the correct amount of pound 
signs to match the number of digits in the unique identifier field. You can use symbols 
such as (-) or (A) to skip or replace a digit. In the Test field, enter numbers equaling the 
required digits to test that the correct amount of pound signs have been entered. The 
results field will display what will be read if the test numbers were decoded. ##### with 
test data of 12345 will display 12345 in the results field; while A#### will display 
A2345 and #-### will display 1345.

6. Select the barcode type form the list. 

7. Enter Calculate Light on Dark settings.

Dark on light is used for visible barcodes. Light on dark is used for invisible barcodes.

Note: Invisible barcodes require the use of the invisible barcode camera.
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Linear Barcodes

Readable Image Types
8. If a checksum characters appears with your barcode, enable the Checksum Character 
feature.

9. Click Threshold.

The Threshold window appears. This window brings up the camera image and allows 
you to adjust the black areas outside of the image.

10. Enter Threshold settings.

The Adaptive Global, Adaptive Local, and Fixed settings allow you to adjust the amount 
of black and white space displayed around the image (and is the most commonly used 
format). Adaptive Global adjusts the circle around the image to the maximum image 
allowed by the camera. Local reduces the area closest to the image and Fixed allows you 
to manually adjust the area. The Line intensity graph tells you to draw a line completely 
through the image. It then displays the intensity highs and lows. Keep drawing lines 
until you end up in the middle to achieve the best readability. 

11. Click OK.

You can enable Log reads to enter data in the log file. Checking Outline Read places a 
green outline around the image based on your threshold settings. You can show the 
Thresholds settings.
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OCR Alphanumerics
Readable Image Types
OCR Alphanumerics

The camera can decode OCR alphanumerics. You must train the software to read the 
numbers properly. This may take some time, as for each job each character must be 
trained.

Note: The OCR alphanumeric must be read left to right. You can change the orientation of the 
camera image via “Image Refinement Settings” on page 5-2 to ensure proper readability. 

OCR Alphanumerics Template Placement

The following items provide some recommendations for how to place OCR 
alphanumerics in the MCS Printer software template.

• Size >= 6 pt <= 8 pt
• Font OCR A, or OCR B
• DPI >= 300dpi
• Clear Zone - an area surrounding the image that has nothing but white space.

Although the MicroVision camera software can learn many fonts for OCR, we 
recommend standardizing on OCR A or B, since they are Fixed Pitch Fonts, rather than 
Proportional Pitch Fonts. Fixed Pitch means that each character is the same size 
(particularly width), which is necessary for a uniform identification of OCR. It is 
recommended that the software be standardized on a seven digit number to avoid 
duplicate printing. All numbers should have leading zeros, for example, “0002456”.

OCR Alphanumerics Tool Configuration

The OCR Alphanumerics tool allows you to configure how the camera decodes the 
OCR image. You can save the trained characters and use them for similar jobs.

To configure OCR alphanumerics:

1. Click the Camera tab.

2. Click the OCR Tool icon.

A message appears asking you if have existing configurations.

3. Click Yes to select from a list of existing setups or No to create a new setup.

12345
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OCR Alphanumerics

Readable Image Types
If Yes, a list of existing setups appears. Select the desired item from the list and click 
OK. If No, a Save dialog appears requesting a name for this file. Provide a name, click 
Save, and proceed with the steps remaining in this procedure.

4. Enter the decode Timeout.

The decode time sets how long the camera is given to read the image before a misread is 
reported and the camera moves on to next image. Typically this is left at 50 seconds. The 
number should never be increased over the speed at which you are running. For 
example, if you are running at 10,000, the number should not be more than 100 (1/10000 
equals .0001 which equals 100 ms).

5. Review the Character Length.

This sets how many digits are in the unique identifier. Enter the correct amount of pound 
signs to match the number of digits in the unique identifier field. You can use symbols 
such as (-) or (A) to skip or replace a digit. In the Test field, enter numbers equaling the 
required digits to test that the correct amount of pound signs have been entered. The 
results field will display what will be read if the test numbers were decoded. ##### with 
test data of 12345 will display 12345 in the results field; while A#### will display 
A2345 and #-### will display 1345.

6. Enter Calculate Light on Dark settings.

Dark on light is used for visible barcodes. Light on dark is used for invisible barcodes.

7. Enter the Minimum score.
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OCR Alphanumerics
Readable Image Types
OCR is the comparison of the trained shapes to the shapes the camera picks up on the 
image. No image will match trained characters 100% due to general printing 
imperfections; therefore, a minimum score is used for comparison. 70% is the 
recommended minimum score.

8. Click Threshold.

The Threshold window appears. This window brings up the camera image and allows 
you to adjust the black areas outside of the image. For OCR images you need to 
configure blob settings. 

9. Click Outline Blobs.

There may be some background images close to or surrounding the actual numbers. 
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OCR Alphanumerics

Readable Image Types
Note: You can also use the blue rectangle later to narrow the visible area and eliminate blobs. 

10. Enter Threshold settings.

Reduce the numbers until the actual OCR is readable but not distorted.
11. Click OK.

12. Use your arrow keys to highlight a question mark in the read field. 

The alphanumeric pertaining to that position flashes. 
13. To train, enter the number you wish the flashing item to be recognized as. 

14. Click Train. 
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OCR Alphanumerics
Readable Image Types
Outlines turn green when trained. Alphanumerics should only be trained one time, even 
if they appear multiple times in a particular image. Multiple training of alphanumerics 
will slow down processing.

15. Repeat this recognition (steps 1-14) for every alphanumeric needed. 

This may take some time. Trained numbers are listed in the table. You can delete and 
retrain items as needed.

16. Check additional options.

You can enable Log reads to enter data in the log file. Checking Outline Read places a 
green outline around the image based on your threshold settings. You can show the 
Thresholds settings and you can enable the Calculate Grade option. The calculate grade 
option provides a score on barcode matching. 
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OCR Alphanumerics

Readable Image Types
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Chapter 6: Troubleshooting and Maintenance
In This Chapter

• Software 
Diagnostics

• Machine 
Diagnostics 
The following sections can help you troubleshoot printing 
problems. The troubleshooting tables below can help you identify 
common problems. 

When problems occur, MCS asks that you run the Debug utility 
prior to contacting technical support. This will help us more 
quickly identify the problem and provide a solution.

Software Diagnostics

A variety of diagnostics tools are available through the 
Diagnostic interface accessed via CTRL-ALT-3.

Configuration Files

You can access the configuration files used to make advanced-
level changes to software operation.

Camera Images

You can save and load the images to help isolate specific 
decoding issues.
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Machine Diagnostics

Troubleshooting and Maintenance
Debug Utility

To run the Debug Utility:

1. With the camera software open, press CTRL-ALT-3.

The Debug window appears.

2. Click Connect to the Debugger.

3. Minimize the spy window.

4. Click Connect to Debugger a second time. 

Debug information is placed in the spy window. 
5. E-mail debug information to technicalsupport@mcspro.com.

Machine Diagnostics

This feature tests for printing and camera operation. 

Note: Swing arm operation is not supported in this feature.

To enter I/O test:

1. Select I/O Test from the File menu.

2. Select one of the desired testing operations.

Button Operation

Activate Diverter Activates the diverter station to test if misreads are 
being sent to the bin. This helps verify that system 
keeps running even when errors occur.

Activate e-stop Activates e-stop to verify proper operation.

Test serial 
connection

Establishes a connection to verify connectivity.

Trigger Camera Test fires the camera through the controller to verify 
connectivity.
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Chapter 7: Configuration Files
The following tables describe each line of the settings file for a variety of MCS systems.

Perfect Match System Settings.ini

Setting Description

[System] System-level settings

Setup Mode=0 Used to set up the machine with the software. 

Encoder Present=1 1 is used for an external encoder. 0 if you were using collars for the cycle and 
encoder tics.   

Encoder Reset Sensor=4 Encoder Reset is used when installing an external encoder such as the one used 
on the MCS inkjet (RSI). This gives the encoder a starting point, which resets 
with a collar sensor.   

Encoder StartStop Msecs=500 Tells the encoder when to reset when using an external encoder such as a flow 
master. 

Cycle Trigger Ticks=0 Used for the centering of the Exit sensor in a given cycle. Resets the zero point.

Cycle Sensor=0 ;0=Encoder-triggered Cycle comes from a 0 (encoder) or a 1 collared sensor (Trigger) .

Exit Sensor=1 Used to calculate your cycles. You may also change where your input would 
be. The exit sensor can be put in any of the four inputs on the IO box. You just 
need to change the number. This must match the physical input number on the 
controller.

Output Sensor=2 The output sensor is used to catch a missing piece after the exit sensor. If there 
is no piece, the system will shut down. This must match the physical output 
number on the controller.

Data Mask

Data Trim

Sensor Invert Bitfield=00000001

Sensor Active Polarity=00000000

Misread Trigger Count=0

Mismatch Trigger Count=0

Print Que Len Trigger Count=5

Enforce Sequential Reads=0

Sequential Increment=1

Ignore Leading Cam Reads=1

Ignore Exit Sensor on Encoder Stop=1

Dupe Checking Enabled=0

Enable Output Check=0

Output Clear On Stop=0

Trigger Variance=0.4
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Perfect Match System Settings.ini

Configuration Files
Cam Read Variance=0.05

Auto Print Mode=1  ;0=Never,1=On Cycle,2=On 
Encoder Start

[Selective Inserting]

Enabled=0

Polarity=0

Pre-Data Delay=5

Latch Pulsewidth=10

Post-Data Delay=5

Feeder1 Field =6

Feeder2 Field =7

Feeder3 Field =8

Feeder1 Number=4

Feeder2 Number=5

Feeder3 Number=6

[Sensor Debounces]

Sensor1 Debounce Count        = 50   ;Exit Sensor

Sensor2 Debounce Count        = 0    ;Output Sensor

Sensor3 Debounce Count        = 0    ;Spare Sensor

Sensor4 Debounce Count        = 0    ;Encoder1 "Sync" 
signal

Sensor5 Debounce Count        = 100  ;Camera1 Trigger

Sensor6 Debounce Count        = 100  ;Camera2 Trigger

Sensor7 Debounce Count        = 100  ;Camera3 Trigger

Sensor1 Debounce Count Source = 1 ;0=>Encoder1 
ticks, 1=>Milliseconds

Sensor2 Debounce Count Source = 0 ;0=>Encoder1 
ticks, 1=>Milliseconds

Sensor3 Debounce Count Source = 0 ;0=>Encoder1 
ticks, 1=>Milliseconds

Sensor4 Debounce Count Source = 0 ;0=>Encoder1 
ticks, 1=>Milliseconds

Sensor5 Debounce Count Source = 1 ;0=>Encoder1 
ticks, 1=>Milliseconds

Sensor6 Debounce Count Source = 1 ;0=>Encoder1 
ticks, 1=>Milliseconds

Sensor7 Debounce Count Source = 1 ;0=>Encoder1 
ticks, 1=>Milliseconds

[Camera 1]

IP=localhost

Enabled=1

Cycles From Exit=13

Setting Description
7-2
User’s Manual



Perfect Match System Settings.ini
Configuration Files
Trigger Source=0  ;0=encoder,5=Trig-1,6=Trig-2,etc.

Trigger Tick Count=1

[Camera 2]

IP=localhost

Enabled=1

Cycles From Exit=11

Trigger Source=0  ;0=encoder,5=Trig-1,6=Trig-2,etc.

Trigger Tick Count=1

[Camera 3]

IP=localhost

Enabled=1

Cycles From Exit=9

Trigger Source=0  ;0=encoder,5=Trig-1,6=Trig-2,etc.

Trigger Tick Count=1

[Printer]

IP=localhost

Enabled=0

Port Number=700

Field1=1

Field2=2

Field3=3

Field4=4

[Diverter]

Enabled=1

Output=1

Cycle Offset=12

Delay Source=0  ;0=encoder,1=millisec timer

Delay Ticks=0

Delay Time=0.0

[I/O]

Comm Port=1

Comm Baud=115200

EStop Output=2

[Log]

Folder=C:\

Date-Time Format="%m%d%y-%H%M%S"

;log?, e-stop?, trigger count, log code, log text, EStop 
Message

App Open        = 1,0,1,A,Program Start

App Close       = 1,0,1,B,Program End

Transport Stop  = 1,0,1,C,Transport Stop

Setting Description
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Transport Start = 1,0,1,D,Transport Start

Piece Fail      = 1,0,1,E,Piece Fail

Piece Success   = 1,0,1,F,Piece OK

Piece Removed   = 1,0,1,G,Piece Removed

Duplicate Piece = 1,0,1,H,Piece Duplicated

Invalid Key     = 1,1,1,I,Invalid Key

[Debug]

Enabled=1

Debug Filename=

Show Timestamps=1

Mask=-1

Setting Description
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IR Track System Settings.ini

Setting Description

[System]

Encoder.Ticks.Per.Inch   = 300 This is the unit of measure that the system will use; It will always be set to 300.

Run.Screen.List.Len      = 32 Represents the number of lines you want to view on the Run Tab.

Setup.Mode               = 0   Disables all EStops and their Dialogs

Password                 = MCS

Time.Stamp.Ratio         = 0.05

[Registration Mark]

Distance.Inches          = 14 Represents the distance between registration marks on your form; it is generally 
the size of your form (11" form, 17" form, etc.).Distance between registration 
marks.

Required Manual Setup

Double.Trigger.Inches    = 13 Represents the distance you want surveyed for double detection; if the trigger 
sensor is tripped this value (X) or less from the last trigger, it will send a E-Stop 
signal to the rewinder, indicating a "Double Detect". This usually indicates that 
the sensor has been triggered by something in addition to the registration mark. 
This value is always entered as 1 inch smaller than the Distance.Inches value.  
;EStop if mark detected this distance or less from previous.

Required Manual Setup

Missing.Trigger.Count    = 2 Indicates the threshold for the number of registration marks that can be missed 
before an E-Stop signal will be sent; the system monitors the number of 
encoder ticks that have occurred since the last trigger -- if the value reaches 
Missing.Trigger.Count times the Encoder.Ticks.Per.Inch, then an error pops up 
on screen indicating that X number of forms have passed without seeing a 
registration mark.   ;EStop if this many successive registration marks missed.

[Camera 1] Read Camera

Trigger.Ticks             = 0 A delay mechanism for tripping the camera. It uses encoder ticks as a unit of 
measure. This value is recommended to always stay at 0.   ;Trigger camera N 
encoder ticks after registration mark.

Required Manual Setup

Barcode.Num.Digits        = 14 The number of characters or digits that the barcode in your trim area represents. 
For instance, if the barcode was created from a 16-digit number, then you 
would enter 16 on this line.  ;Number of digits encoded in laser barcode.

Required Manual Setup

Derive.Misread.Barcodes   = 1 This line item lets the IR Track software determine the next barcode in 
sequence, in case it doesn't actually read it. The value is either 1 (On) or 0 (Off). 
This can only be used when the Trim Area barcodes (printed by your laser 
printer) follow a pattern. If the numbers are in random order, then this function 
must be turned off (0).    ;Derive barcode if camera misreads .

Derive.Sample.Len         = 3 The threshold number of barcodes that need to be read successfully AND in 
succession, to determine the pattern for the derive function.   Any value less 
than 3 is not recommended.   ;Verify sequence for this many pieces before 
allowing derives.

Misread.Trigger.Count     = 5 The threshold number for missed or derived Trim Area barcodes to occur 
before an E-Stop message is sent  ;EStop if this many successive misreads/
derives occur.

[Camera 2] Verify Camera 1
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Enabled               = 1 Value is either 1 (on) or 0 (off).

Trigger.Ticks         = 2400 This value is the distance that your continuous form will travel after the Trigger 
Sensor is tripped until the Verify (Invisible) camera will fire. It is measured in 
Encoder Ticks (unit of measurement is always 300). To determine this value, 
you measure the distance with a ruler, and then multiply that number by 300. 
This value can NEVER be greater than the distance between registration marks.        
;Trigger camera N encoder ticks after registration mark.

Required Manual Setup

Read.Mask             = ####### This entry is to define the characters that you want to compare from Camera 1 
successful read. A # sign indicates that the character located at that position in 
the string is to be used for comparison. A “-” sign indicates that the character 
located at that position is to be ignored during comparison. In this example, the 
first 7 characters are the only ones to be considered for matching status, while 
the last 7 are being ignored.;#=copy digit, -=skip digit, other=replace digit.

Required Manual Setup

Write.Mask            = ####### This entry is to define the number of characters to be compared for matching 
purposes. The number of "#" signs must equal the number of "#" signs defined 
in the Read.Mask line above it.    ;#=copy digit, other=replace digit.

Required Manual Setup

Misread.Trigger.Count = 5 Defines the threshold of consecutive misreads before a stop signal is to be sent 
to the system. ;EStop if this many successive misreads occur

Fire.Sequence         = 1010101010101010 Defines the pattern at which the Verify camera will occur. This is ALWAYS 16 
characters in length. In this example, the first piece will be verified, the second 
is not, the third piece is verified, etc., etc., etc.... ;1=Fire, 0=Skip Piece (16 
digits)

[Camera 3] Verify Camera 2

Enabled               = 1

Trigger.Ticks         = 2400          Trigger camera N encoder ticks after registration mark.

Required Manual Setup

Read.Mask             = -------####### #=copy digit, -=skip digit, other=replace digit

Required Manual Setup

Write.Mask            = #######       #=copy digit, other=replace digit

Required Manual Setup

Misread.Trigger.Count = 5            EStop if this many successive misreads occur.

Fire.Sequence         = 0101010101010101 1=Fire, 0=Skip Piece (16 digits)

[Printer]

Enabled                 = 1 Printer Enabled:   This will always be "on" or a value of 1. 

IP                      = localhost Defines how the printer is connected. It will ALWAYS be "localhost", meaning 
the inkjet software is located on the same PC.

Port                    = 700 ALWAYS port 700

Piece.Width.Inches      = 1.5 This entry needs to match the size of your template, as defined in the inkjet 
software as Paper Width ;From Printer's "File/Print Setup": Paper Size - Width

Required Manual Setup

Setting Description
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Dist.From.Sensor.Inches = 6.25 This entry needs to match the value of the "Distance From Sensor" that you 
measured on your form, and also entered in the inkjet software. ;From Printer's 
"File/System Setup": Board1 - Distance from sensor.

Required Manual Setup

Print.Warning.Msecs     = 50  Timing Graph's "Yellow Box" size (only affects graph display).

[Controller]

Comm.Port              = 1 Comm.Port =  Defines which serial connection you are communicating with the 
PC.

Sensor.Invert.Bitfield = 00000001 On option to change the bitfield of the programmable sensor of the IR Track. 
This is usually left as is, and really would only need to change if a different type 
of sensor was used.

Cycle.Sensor           = 2 The number that is placed here is the actual connection that is made on the 
camera controller. In this example, the sensor is physically connected to "Input 
2" as marked on the back of the camera controller.

EStop.Output           = 1 The number that is placed here is also the actual connection that is made on the 
camera controller. In this example, the cable that is connected to the rewinder 
for the stop signal, is physically connected to "Output 1" as marked on the back 
of the camera controller.    ;Relays 1-4.

EStop.Polarity         = 0E Only 2 choices for entry ->  "1" or "0";   This is determined by the stop 
conditions of the transport-- is it a normally open circuit?  or a normally closed 
circuit?    ;0=>Normally open, 1=>Normally closed.

Camera.Trigger.PWMsecs = 20

[Log]

Folder=C:\

Date-Time Format="%m%d%y-%H%M%S" log?, e-stop?, trigger count, log code, log text, EStop Message

App Open        = 1,0,1,A,Program Start

App Close       = 1,0,1,B,Program End

Transport Stop  = 1,0,1,C,Transport Stop

Transport Start = 1,0,1,D,Transport Start

Piece Fail      = 1,0,1,E,Piece Fail

Piece Success   = 1,0,1,F,Piece OK

Piece Derived   = 1,0,1,G,Piece Removed

[Debug]

Enabled=1

Debug Filename=

Show Timestamps=1

Mask=-1

Setting Description
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